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Background Modeling
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Announcements

e Course webpage
~ http://www.vision.rwth-aachen.de/teaching/
~ Slides will be made available on the webpage

e L2P electronic repository
~ Exercises and supplementary materials will be posted on the L2P

e Please subscribe to the lecture on the Campus system!
> Important to get email announcements and L2P access!
» Bachelor students please also subscribe
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Course Outline

e Single-Object Tracking
> Background modeling
» Template based tracking
» Color based tracking
» Contour based tracking
» Tracking by online classification
» Tracking-by-detection

e Bayesian Filtering
e Multi-Object Tracking

e Articulated Tracking
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Image source: Tobias Jaeggli
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Topics of This Lecture

e Motivation: Background Modeling

e Simple Background Models
> Background Subtraction
> Frame Differencing

e Statistical Background Models
> Single Gaussian
> Mixture of Gaussians
» Kernel Density Estimation

e Practical Issues and Extensions
> Background model update
~ False detection suppression
> Shadow suppression

- Applications 5 Leibe



Computer Vision Il, Summer’14

CI-FN
UNIVERSITY
Motivation: Tracking from Static Cameras
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B. Leibe Video source: Wolfgang Mehner



Motivation

e Goals

> Want to detect and track all kinds of objects in a wide variety
of surveillance scenarios.

= Need a general algorithm that works for many scenarios.

> Video frames come in at 30Hz. There is nhot much time to
process each image.

= Real-time algorithms need to be very simple.

e Assumptions
» The camera is static.
> Objects that move are important (people, vehicles, etc.).

e Basic Approach
> Maintain a model of the static background.

> Compare the current frame to this model to detect objects.
B. Leibe
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Slide adapted from Robert Collins



Computer Vision Il, Summer’14

Background Modelling Results
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Topics of This Lecture

e Simple Background Models
> Background Subtraction
- Frame Differencing
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Simple Background Subtraction

M(t)

e Procedure
> Background model is a static image (without any objects).

~ Pixels are labeled based on thresholding the absolute intensity
difference between current frame and background.

Slide credit: Robert Collins B. Leibe
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Background Subtraction Results

e Observation

» Background subtraction does a reasonable job of extracting the
object shape if the object intensity/color is sufficiently different
from the background.

e What are the limitations of this simple procedure?

. 11
Slide credit: Robert Collins B. Leibe



RWTH
Background Subtraction: Limitations

e Outdated reference frame

~ Objects that enter the scene and
stop continue to be detected...

...making it difficult to detect new
objects that pass in front of them.

~ |If part of the assumed static back-
ground starts moving...

...both the object and its negative
ghost (the revealed background) are
detected.
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Slide credit: Robert Collins B. Leibe
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Background Subtraction: Limitations

e |[llumination changes

» Background subtraction is sensitive
to illumination changes and unim-
portant scene motion (e.g., tree
branches swaying in the wind).

e Global threshold

> A single, global threshold for the
entire scene is often suboptimal.

= Need adaptive model with
local decisions

Slide credit: Robert Collins B. Leibe
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Simple Frame Differencing

M(t)

e Other idea
~ Background model is replaced with the previous image.
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Slide credit: Robert Collins B. Leibe



RWTH
Frame Differencing Observations

e Advantages

- Frame differencing is very quick to adapt
to changes in lighting or camera motion.

- Objects that stop are no longer detected.

- Objects that start up no longer leave behind
ghosts.

e Limitations

~ Frame differencing only detects the leading
and trailing edge of a uniformly colored
object.

~ Very few pixels on the object are labeled.

» Very hard to detect an object moving
towards or away from the camera.
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Slide credit: Robert Collins B. Leibe



RWTH
Differencing and Temporal Scale

k| K| #

1(t) D(-1) D(-3) D(-5) D(-9) D(-15)

e More general formulation
. Define D(N) = ||I(t)—I(t+ N)|

e Effect of increasing the temporal scale

~ More complete object silhouette, but two copies of the object
(one where it used to be, one where it is now).
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. 16
Slide credit: Robert Collins B. Leibe



RWTH
Three-Frame Differencing

e Improved approach to handle this problem

where the object was
and where it is now d

where the object is now!

D(-15)

D(+15)
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where the object is now
and where it will be

Slide credit: Robert Collins B. Leibe
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Three-Frame Differencing

# frames

skipped
1
5
This worked well
for the person
» 15
25

e Problem

> Choice of good frame-rate for three-frame differencing
depends on size and speed of object.

Slide credit: Robert Collins B. Leibe
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Adaptive Background Subtraction

M(t)

o 1(6) + (1—a)B(t-1)
a

> Current image is “blended” into the background model with «.
19
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Slide credit: Robert Collins B. Leibe



RWTH
Adaptive Background Subtraction

e Properties

> More responsive to changes in illumination
and camera motion.

- Small, fast-moving objects are well-segmented,
but they leave behind short “trails” of pixels.

~ Objects that stop and ghosts left behind by
objects that start both gradually fade into the
background.

~ The centers of large, slow-moving objects
start to fade into the background, too!

~ This can be fixed by decreasing the blend
parameter «, but then it takes longer for

ghost objects to disappear...
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Slide credit: Robert Collins B. Leibe



Comparisons
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BG Subtraction Frame Differencing  Adaptive BG Subtract.

Slide adapted from Robert Collins
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Discussion

e Background subtraction / Frame differencing
» Very simple techniques, historically among the first.
> Straight-forward to implement, fast to test out.
> We’ve seen some fixes for the most pressing problems.

e Remaining limitations
> Rather heuristic approach.
~ Leads to relatively poor foreground/background decisions.

~ Optimal temporal scale still depends on object size and speed.

» Global threshold is often suboptimal for parts of the image.

= Very fiddly in practice, requires extensive parameter tuning.

e Let’s try to come up with a better founded approach
> Using a statistical model of background probability...

B. Leibe
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Topics of This Lecture

e Statistical Background Models
> Single Gaussian
> Mixture of Gaussians
» Kernel Density Estimation

B. Leibe
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Gaussian Background Model

e Statistical model

> Value of a pixel represents a measure-
ment of the radiance of the first object
intersected by the pixel’s optical ray.

~ With a static background and static
lighting, this value will be a constant
affected by i.i.d. Gaussian noise.

» Test if a newly observed pixel value has a high likelihood
under this Gaussian model.

= Automatic estimation of a sensitivity threshold for each pixel. ,
B. Leibe

S

A o Idea

§ ~ Model the background distribution of each pixel by a single
— Gaussian centered at the mean pixel value:
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RWTH
Recap: Maximum Likelihood Approach

e Computation of the likelihood
» Single data point: p(xnw)
~ Assumption: all data points X = {:cl, ..,xn} are independent
L(0) = p(X|0) = H p(x,|0)
» Log-likelihood
E#)=—-InL(#) = — Zlnp(mn\é’)

e Estimation of the parameters 6 (Learning)

> Maximize the likelihood (=minimize the negative log-likelihood)
— Take the derivative and set it to Zero.

-y B
p(x,|0)

Slide credit: Bernt Schiele B. Leibe
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RWTH
Recap: Maximum Likelihood Approach

e For a 1D Gaussian, we thus obtain

1
= N E Ty, “sample mean”

e In a similar fashion, we get

~2 1 ~\ 2 “« : ”
6" = = E (xn, — f) sample variance
n=1

e 0= (ft,6) is the Maximum Likelihood estimate for the
parameters of a Gaussian distribution.

 Note: the estimate of the sample variance is biased.

N
Better use 2 _ 1 (2 — )2
N -1 ‘
n= 26
B. Leibe
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Online Adaptation (1D Case)

e Once estimated, adapt the Gaussians over time
> We can compute a running estimate over a time window

a0+ = 50 4 2oy L erem

N N
1

(5.2)(t+1) _ (5.2)(t) 4+ (x(t—|—1) . ﬂ(t+1))2

N —1
1
N —1

(x(t+1—T) . /:b(t+1))2

> However, distribution is non-stationary (and newer values are

more important) = better use Exponential Moving Average filter

AtD — (1= )p® 4 az®+D
(52)(t+1) — (1 . a)((}Q)(t) + Oa(:B(H_l) - [L(H_U)Q
with a fixed learning rate c.

B. Leibe
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Problem: Complex Distributions

il

e L B R

=of
ok
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. [
T
=
%
100
]
. -
L. "
E0p L " .
00 50 na =0

Bi-modal distribution caused by specularities on the water surface

=> A single Gaussian is clearly insufficient here...

B. Leibe
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Image source: Chris Stauffer
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RWTH
Problem: Adaptation Speed, Sensitivity

e |f the background model adapts too slowly...

> Will construct a very wide and inaccurate model with low
detection sensitivity

e |f the model adapts too quickly...
~ Leads to inaccurate estimation of the model parameters

> The model may adapt to the targets themselves (especially
slow-moving ones)

e Design trade-off

~ Model should adapt quickly to changes in the background
process and detect objects with high sensitivity.

> How can we achieve that?

B. Leibe
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MoG Background Model

e Improved statistical model

» Large jumps between different pixel values !|
because different objects are projected onto
the same pixel at different times. |

> While the same object is projected onto the
pixel, small local intensity variations due to
Gaussian noise.

0 L

e ldea
~ Model the color distribution of each pixel by a mixture of K

Gaussians K
p(x) = ZWkN(Xn|”ka k)
k=1

» Evaluate likelihoods of observed pixel values under this model.

> Or let entire Gaussian components adapt to foreground objects
and classify components as belonging to object or background.
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B. Leibe Image source: Chris Bischop




CHEN
. . UNIVERSITY
Recap: Mixture of Gaussians

 “Generative model” p(x) =Y mN (Xnlpy, Tie)
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Slide credit: Bernt Schiele B. Leibe Image source: C.M. Bishop, 2006



Recap: EM Algorithm

e Expectation-Maximization (EM) Algorithm
~ E-Step: softly assign samples to mixture components
WJN(Xn“‘ja Ej)

N
Zk:l 7"'k:-/\/‘(xnhjlka Zk)

> M-Step: re-estimate the parameters (separately for each mixture
component) based on the soft assignments

Vi (Xn) < Vj=1,....K, n=1,...,N

< N
s N — Z% X, ) = soft number of samples labeled j
E n=1
= N
‘fn ThHeW %
E N
— N
L 1
> ﬂnew e _ ’)/ X X
=
g Z?GW Z 73 Xn Xn A new>(xn . ﬂ?eW)T
&
J n=1 32

Slide adapted from Bernt Schiele B. Leibe



RWTH
Stauffer-Grimson Background Model

e Very popular model
> Used in many tracking approaches
> Suitable for long-term observations (finding patterns of activity)

C. Stauffer, W.E.L. Grimson, Adaptive Background Mixture Models for

Real-Time Tracking, CVPR 1998.
B. Leibe
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Image source: C. Stauffer



http://www.ai.mit.edu/projects/vsam/Publications/stauffer_cvpr98_track.pdf‎
http://www.ai.mit.edu/projects/vsam/Publications/stauffer_cvpr98_track.pdf‎
http://www.ai.mit.edu/projects/vsam/Publications/stauffer_cvpr98_track.pdf‎
http://www.ai.mit.edu/projects/vsam/Publications/stauffer_cvpr98_track.pdf‎
http://www.ai.mit.edu/projects/vsam/Publications/stauffer_cvpr98_track.pdf‎

RWTH
Stauffer-Grimson Background Model

e |dea
> Model the distribution of each pixel by a mixture of K Gaussians

K
p(x) =Y meN(xn |ty k) where Xy = o2I
k=1
» Check every new pixel value against the existing KX components
until a match is found (pixel value within 2.5 o, of u,).
~ If a match is found, adapt the corresponding component.

- Else, replace the least probable component by a distribution
with the new value as its mean and an initially high variance and
low prior weight.

-~ Order the components by the value of w, /o, and select the best
B components as the background model, where

b
. Wi
B = E — >T
argmbm( o > )
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RWTH
Stauffer-Grimson Background Model

e Online adaptation

> Instead of estimating the MoG using EM, use a simpler online
adaptation, assigning each new value only to the matching
component.

- Let M, , = 1 iff component £ is the model that matched, else 0.

7T,(€t+1) = (1— a)w,(:) + a My, ¢

~ Adapt only the parameters for the matching component

1
we ™ = (1= o) + pa Y
S = (1 )3 + p(al ) — g ) @D )T
where

p = aN (x,|py, i)
(i.e., the update is weighted by the component likelihood)

, 35
B. Leibe
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RWNTH
Discussion: Stauffer-Grimson Model

e Properties

~ Static foreground objects can be integrated into the mixture
- Advantage: This doesn’t destroy the existing background model.

- If an object is stationary for some time and then moves again, the
distribution for the background still exists

= Quick recovery from such situations.

-~ Ordering of components by w, /o,

- Favors components that have more evidence (higher w,)
and a smaller variance (lower o;).

= Those are typically the best candidates for background.

» Model can adapt to the complexity of the observed distribution.

- If the distribution is unimodal, only a single component will be
selected for the background.

= This can be used to save memory and computation.

36
B. Leibe
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UNIVERSITY
Problem: Outdoor Scenes

0] 100 200 300 400 500 600 700 800 900

e Dynamic areas
» Waving trees, rippling water, ...
> Fast variations

=> More flexible representation
needed here.
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B. Leibe Image & Video source: A. Elgammal
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RWTH
Recap: Kernel Density Estimation

e Estimating the probability density from discrete samples

() ~
> Approximation: P(X —_—
NV
fixed V fixed K
determine K determine V
Kernel Methods  K-Nearest Neighbor
e Kernel methods t
> Example: Determine - 1.
the number K of data .-
points inside a fixed . >
hypercube... B

. 38
Slide credit: Bernt Schiele B. Leibe



RWNTH
Recap: Kernel Density Estimation

e Parzen Window
» Hypercube of dimension D with edge length h:

o 1, |’UJ7J %, Z:L,D
k(u)—{ 0, else

“Kernel function”

N
X — X
K=) k ")y V= [ k(u)du=nh"
SR V= [y
~ Probability density estimate:
N
K 1 X — X,
P) ~ N = o ;k( )

Slide credit: Bernt Schiele B. Leibe
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Recap: Parzen Window

e Interpretations

1. We place a kernel window k at Ly
location x and count how many o oo ®
data points fall inside it. o °

2. We place a kernel window k around

each data point x, and sum up
their influences at location x.

= Direct visualization of the density.

o Still, we have artificial discontinuities at the cube
boundaries...

> We can obtain a smoother density model if we choose a
smoother kernel function, e.g. a Gaussian

B. Leibe
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Kernel Background Modeling

e Nonparametric model of background appearance

~ Very flexible approach, can deal with large amounts of
background motion and scene clutter

A. Elgammal, D. Harwood, L.S. Davis, Non-parametric Model for
Background Subtraction, ECCV 2000.
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41
Video source: Ahmed Elgammal

B. Leibe


http://www.cs.umd.edu/users/elgammal/docs/bgmodel_ECCV00_postfinal.pdf
http://www.cs.umd.edu/users/elgammal/docs/bgmodel_ECCV00_postfinal.pdf
http://www.cs.umd.edu/users/elgammal/docs/bgmodel_ECCV00_postfinal.pdf
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http://www.cs.umd.edu/users/elgammal/docs/bgmodel_ECCV00_postfinal.pdf
http://www.cs.umd.edu/users/elgammal/docs/bgmodel_ECCV00_postfinal.pdf

Kernel Background Modeling

e Nonparametric density estimation

~ Estimate a pixel’s background distribution using the kernel
density estimator K(-) as

1 N
=~ Z K(x® —x®)
1=1

. Choose K to be a Gaussian N(0, X) with X = diag{c }. Then
(ac(t)—:c(z))2
1 J J

N d
1 1 —3 3
(t) S e 73
N 1;[1 2o

. A pixel is considered foreground if p(x(*)) < 6 for a threshold 6.

- This can be computed very fast using lookup tables for the kernel
function values, since all inputs are discrete values.

- Additional speedup: partial evaluation of the sum usually sufficient
42
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B. Leibe



RWNTH
Results Kernel Background Modeling

e Performance in heavy rain
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B. Leibe Video source: Ahmed Elgammal



RWTH
Results Kernel Background Modeling

e Results for color images

- l‘ f”"' - A ’j '?n‘r'."— ] ' s W
' A

e Practical issues with color images
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Video source: Ahmed Elgammal

B. Leibe
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Topics of This Lecture

e Practical Issues and Extensions
> Background model update
~ False detection suppression
> Shadow suppression

- Applications 5 Leibe

46
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RWTH
Practical Issues: Background Model Update

e Kernel background model
> Sample NN intensity values taken over a window of W frames.

e FIFO update mechanism
~ Discard oldest sample.

» Choose new sample randomly from each interval of length
W/ N frames.

e When should we update the distribution?

~ Selective update: add new sample only if it is classified as a
background sample

» Blind update: always add the new sample to the model.

B. Leibe

47



Updating Strategies

e Selective update

> Add new sample only if it is classified as a background sample.

~ Enhances detection of new objects, since the background model
remains uncontaminated.

~ But: Any incorrect detection decision will result in persistent
incorrect detections later.

= Deadlock situation.

e Blind update
> Always add the new sample to the model.

> Does not suffer from deadlock situations, since it does not
involve any update decisions.

» But: Allows intensity values that do not belong to the
background to be added to the model.

= Leads to bad detection of the targets (more false negatives).
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B. Leibe



RWTH
Solution: Combining the Two Models

e Short-term model

> Recent model, adapts to changes quickly to allow very sensitive
detection

» Consists of the most recent [V background sample values.

» Updated using a selective update mechanism based on the
detection mask from the final combination resulit.

e Long-term model

~ Captures a more stable representation of the scene background
and adapts to changes slowly.

~ Consists of [V samples taken from a much larger time window.
» Updated using a blind update mechanism.

e Combination
> Intersection of the two model outputs.
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B. Leibe [A. Elgammal, D. Harwood, L. Davis, ECCV’00]




RWTH
Extension: False Detection Suppression

e Problem

> Small camera motion (e.g., due to wind swaying) may still result
in false detections.

e Workaround
- Consider a small circular neighborhood (e.g., 5x5) Ne(x) and
evaluate the pixel under each neighbor’s background model B;:

()Y — Ol
PNe (%) ygﬁ@ﬁ(x | By)

» Threshold py, to determine the foreground pixels.
= Eliminates many false detections, but also some true ones.

~ To avoid losing true detections, add the constraint that an entire
connected component must have moved from a nearby location,
not only some of its pixels.

<
-
"
(]
£
£
-
(7p)
c
L)
2
>
-
(]
-
-
(o
£
(o]
(&)

_ 50
B. Leibe [A. Elgammal, D. Harwood, L. Davis, ECCV’00]




RWTH
Effect of False Detection Suppression

Original video Without false With false
detection suppr. detection suppr.

e Results
» Effects of camera wind shaking are almost entirely suppressed
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Extension: Shadow Suppression

e Shadows are often detected together with the objects
~ Leads to poor localization, should be avoided.

» ldea: Shadowed regions should have the same color as the
neighboring background, only the intensity is lower.

= Use chromaticity coordinates to remove shadows.

B. Leibe
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Color Normalization

e One component of the 3D color space is intensity

~ If a color vector is multiplied by a scalar, the intensity changes,
but not the color itself.

> This means colors can be normalized by the intensity.
- Intensity is givenby [ = R + G + B:
> ,,Chromatic representation*

R G

F = g:
R+G+ B R+G+ B

B B
 R+G+B

b

B. Leibe
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Chromaticity Coordinates

e Observation:
> Since R + G + B =1, only 2 parameters are necessary
- E.g.,onecanuse Rand Gand obtains B=1-R-G

A

G

R+G+B=1

R

»
>

-
-
-

1
1
1
B

» Caveat: cannot distinguish between white and gray anymore!

= Use the normalized (7,g) coordinates, but keep the lightness
s = R + B + G as third coordinate = (r,g,s)

B. Leibe
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Shadow Removal Procedure

e |Idea

» Let <r, g, s> be the expected background pixel color
and <r,, g,, s,> be the observed one.

> Shadows or highlights affect the expected pixel lightness within
certain bounds o < s,/s < .

e Procedure

» Select the subset B of relevant sample points for each pixel
from the stored set A, i.e. those samples that could produce the
observed lightness if affected by shadows:

B:{azi|azi€A/\a<ﬁ<ﬁ}

S

~ Apply the regular kernel background model based on this subset
B using only the (r,g) color components.
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Topics of This Lecture

e Practical Issues and Extensions
> Background model update
~ False detection suppression
> Shadow suppression

~ Applications 5 Leibe

57



RWTHAACHEN
. . . . UNIVERSITY
Applications: Visual Surveillance

e Background modeling to detect objects for tracking
» Extension: Learning a foreground model for each object.
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RWNTH
Applications: Articulated Tracking

e Background modeling as preprocessing step
» Track a person’s location through the scene
» Extract silhouette information from the foreground mask.
~ Perform body pose estimation based on this mask.
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Summary

e Background Modeling

~ Fast and simple procedure to detect moving object in static
camera footage.

- Makes subsequent tracking much easier!
= If applicable, always make use of this information source!

e We’ve looked at two models in detail
> Adaptive MoG model (Stauffer-Grimson model)
> Kernel background model (Elgammal et al.)
- Both perform well in practice, have been used extensively.

e Many extensions available
> Learning object-specific foreground color models
» Background modeling for moving cameras

> o0 0

B. Leibe
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References and Further Reading

 More information on density estimation in Bishop’s book
> Gaussian distribution and ML: Ch. 1.2.4 and 2.3.1-2.3.4.

> Mixture of Gaussians: Ch. 2.3.9and 9

> Nonparametric methods: Ch. 2.5.

e More information on background modeling:

> Visual Analysis of Humans: Ch. 3

> C. Stauffer et al., Adaptive Background Models for Real-Time Tracking, CVPR’98

> A. Elgammal et al., Non-parametric Model for Background Subtraction, ECCV’00
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